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1 - Introduction to
Mapinfo ProViewer

Maplnfo ProViewer provides an easy way to see, print, and share electronic
desktop maps. This convenient map viewer opens tables created using
Pitney Bowes Software products such as Maplinfo Pro or MapXtreme and
displays them in Map and Browser windows. It also opens workspaces and
re-creates Map, Browser, Graph, and Layout windows exactly as they were
created in MaplInfo Pro. Using this product you can display and print maps
and workspaces created in any version of the Pithey Bowes Software
product line.

The purpose of this chapter is to familiarize you with the basics of Maplnfo
ProViewer and provide resources for you to become familiar with it. You
can also get installation assistance from Technical Support, if necessary,
using information in this document.

In this section
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Introduction to MapInfo ProViewer

System Requirements

This product is tested on the following Microsoft Windows Desktop Operating Systems:

* Windows 7 Ultimate 32-bit SP1

* Windows 7 Ultimate 64-bit SP1

* Windows 8.1 32-bit

* Windows 8.1 64-bit

* Windows 2008 Server R2 64-bit SP1

» Windows 2008 Server R2 64-bit SP1 with XenApp 6.0
» Windows 2012 Server R2 64-bit with XenApp 7.5

Dependencies and Prerequisites

The install wizard checks for the following and prompts you if not already on your system; you can
choose to have the install wizard install these requirements, or cancel the installation if you do not
want to proceed.

» Microsoft Office Access database engine 2010 - does not install when the 64-bit office 2010 driver
is installed
» Microsoft .NET Framework 4.5.2 Full

Note: Check the Microsoft website for the minimum requirements for these redistributables and
updates if installing to an unsupported operating system.

Installing Mapinfo ProViewer

To install MapInfo ProViewer:

1. Go to the directory where the ProViewer installer is located and right-click the Setup.exe file and
select Run as administrator from the popup menu to install using elevated privileges. A prompt
for permission to continue displays. Click Allow to proceed (if you do not respond and the message
times-out, the install is unsuccessful).

The wizard begins to lead you through the installation.

2. If any of the prerequisites listed under Dependencies and Prerequisites are not already installed
on your system, then a prompt displays to install them. Click Install.

If you see a message that you are required to reboot, click Yes. You must reboot to continue
with the installation.
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3. In the Welcome screen, click Next.
4. In the License Information screen, click | accept and Next to continue.

5. In the Customer Information screen, type in your user and organization names in the fields
provided. Click Next.

6. In the Destination Folder screen, click Next to accept the default path or click Change to select
a new path.

7. In the Ready to Install screen, click Install to begin the file transfer.
8. In the Completed screen, click Finish to complete the installation of Maplinfo ProViewer.

OpenSource Attribution Notices

QT Assistant 5.2.0

This product contains QT Assistant, version 5.2.0, which is licensed under GNU Lesser General
Public License, Version 2.1, February 1999. The license can be downloaded from:
http://www.gnu.org/licenses/lgpl-2.1.txt. The source code for this software is available from
http://qt-project.org/downloads.

ECW JPEG2000 SDK 3.3

This product contains the ECW JPEG2000 SDK 3.3, which is licensed under the ECW JPEG2000
SDK License. The license can be obtained by contacting ERDAS at
http://erdas.com/Homepage.aspx. The source code for this software is available by contacting
ERDAS at http://lerdas.com/Homepage.aspx.

FDO 3.8.0

This product contains FDO (Feature Data Objects), which is licensed under the Lesser General
Public License (LGPL), Version 2.1, February 1999, Open Source Geospatial Foundation, All rights
reserved. The license can be downloaded from http://fdo.osgeo.org/lgpl.html. The source code
for this software is available from http://fdo.osgeo.org/content/fdo-380-downloads.

Extended WPF Toolkit 1.6.0

This product contains the Extended WPF Toolkit 1.6.0, which is licensed under Microsoft Public
License. The license can be downloaded from http://wpftoolkit.codeplex.com/license. The source
code for this software is available from http://wpftoolkit.codeplex.com.

GeoTools 2.6.1

This product contains GeoTools 2.6.1, which is licensed under GNU Lesser General Public License,
Version 2.1, February 1999. The license can be downloaded from
http://lwww.gnu.org/licenses/lgpl-2.1.html Copyright (C) 1991, 1999 Free Software Foundation,
Inc. The source code for this software is available from
http://sourceforge.net/projects/geotools/files/.
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GeoTools 2.6.5

This product contains GeoTools 2.6.5, which is licensed under GNU Lesser General Public License,
Version 2.1, February 1999. The license can be downloaded from
http://lwww.gnu.org/licenses/Igpl-2.1.html Copyright (C) 1991, 1999 Free Software Foundation,
Inc. The source code for this software is available from
http://sourceforge.net/projects/geotools/files/.

Visualization Toolkit 5.0.1

This product contains the Visualization Toolkit 5.0.1, which is licensed under Visualization Toolkit
(VTK) License, 1993-2008. The license can be downloaded from
http:/lwww.vtk.org/VTK/project/license.html Copyright (C) 1993-2008, Ken Martin, Will Schroeder,
Bill Lorensen, all rights reserved. The source code for this software is available from
http://www.vtk.org.

Features Added in Previous Versions of ProViewer

This section provides a history of the previous changes to the ProViewer product.

New in Proviewer 12.5

New Layout Designer Window

Maplnfo Pro provides a new Layout Designer window that will eventually replace the classic Layout
window. When opening a workspace in Maplnfo ProViewer, you may see either a classic Layout
window or a Layout Designer window in the workspace.

The Layout Designer window includes a toolbar of options for page setup and printing, and for
zooming and panning the layout.

For details and instructions on how to work with the Layout Designer window, see Layout Designer
Window Description in the Help System.

Support for Additional Coordinate Systems

We have added a new PRJ code:

» 5514 — "S-JTSK (Krovak) Coordinate system - Updated"
We have added new EPSG codes:

» "Longitude / Latitude (NOAA GCS_Sphere)", 1, 161
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Adindan Projections

We have added new Adindan projections:

» "Burkina Faso Adindan UTM Zone 30N", 8, 1, 7, -3, 0, 0.9996, 500000, O
 "Burkina Faso Adindan UTM Zone 31N", 8, 1, 7, 3, 0, 0.9996, 500000, 0
+ "Ethiopia Adindan UTM Zone 37N", 8, 1, 7, 39, 0, 0.9996, 500000, 0

WA Project Grid
We have added new WA Project Grid projections:

 "Albany Grid 1984", 8, 13, 7, 117.916666666667, 0, 1.000012, 50000, 4000000

 "Albany Grid 1994", 8, 116, 7, 117.883333333334, 0, 1.0000044, 50000, 4000000

» "Barrow Island and Onslow Grid 1994", 8, 116, 7, 115.25, 0, 1.0000022, 60000, 2600000

» "Broome Grid 1984", 8, 13, 7, 122.333333333334, 0, 1.000003, 50000, 2200000

* "Broome Grid 1994", 8, 116, 7, 122.333333333334, 0, 1.00000298, 50000, 2200000
 "Busselton Coastal Grid 1984", 8, 13, 7, 115.433333333334, 0, 1.000007, 50000, 3900000
* "Busselton Coastal Grid 1994", 8, 116, 7, 115.433333333334, 0, 0.99999592, 50000, 3900000
 "Carnarvon Grid 1984", 8, 13, 7, 113.666666666667, 0, 1.000005, 50000, 3050000
 "Carnarvon Grid 1994", 8, 116, 7, 113.666666666667, 0, 0.99999796, 50000, 2950000

¢ "Christmas Island Grid 1992", 8, 104, 7, 105.625, 0, 1.000024, 50000, 1300000

* "Christmas Island Grid 1994", 8, 116, 7, 105.625, 0, 1.00002514, 50000, 1300000

* "Cocos (Keeling) Islands Grid 1992", 8, 104, 7, 96.875, 0, 1, 50000, 1400000

» "Cocos (Keeling) Islands Grid 1994", 8, 116, 7, 96.875, 0, 0.99999387, 50000, 1500000

* "Collie Grid 1994", 8, 116, 7, 115.933333333334, 0, 1.000019, 40000, 4000000

* "Esperance Grid 1984", 8, 13, 7, 121.883333333334, 0, 1.000012, 50000, 3950000
 "Esperance Grid 1994", 8, 116, 7, 121.883333333334, 0, 1.0000055, 50000, 3950000

» "Exmouth Grid 1984", 8, 13, 7, 114.066666666667, 0, 1.000009, 60000, 2750000

« "Exmouth Grid 1994", 8, 116, 7, 114.066666666667, 0, 1.00000236, 50000, 2650000
 "Geraldton Coastal Grid 1984", 8, 13, 7, 114.666666666667, 0, 1.000016, 50000, 3350000
* "Geraldton Coastal Grid 1994", 8, 116, 7, 114.583333333334, 0, 1.00000628, 50000, 3350000
 "Goldfields Grid 1984", 8, 13, 7, 121.45, 0, 1.000057, 60000, 4000000

* "Goldfields Grid 1994", 8, 116, 7, 121.5, 0, 1.00004949, 60000, 3700000

 "Jurien Coastal Grid 1984", 8, 13, 7, 114.983333333334, 0, 1.00001, 50000, 3550000
 "Jurien Coastal Grid 1994", 8, 116, 7, 114.983333333334, 0, 1.00000314, 50000, 3550000
 "Kalbarri Grid 1994", 8, 116, 7, 114.3152777778, 0, 1.000014, 55000, 3600000
 "Karratha Grid 1984", 8, 13, 7, 116.933333333334, 0, 1.000004, 50000, 2450000

» "Karratha Grid 1994", 8, 116, 7, 116.933333333334, 0, 0.9999989, 50000, 2450000

» "Kununurra Grid 1984", 8, 13, 7, 128.75, 0, 1.000014, 50000, 2000000

 "Kununurra Grid 1994", 8, 116, 7, 128.75, 0, 1.0000165, 50000, 2000000

» "Lancelin Coastal Grid 1984", 8, 13, 7, 115.366666666667, 0, 1.000008, 50000, 3650000

* "Lancelin Coastal Grid 1994", 8, 116, 7, 115.366666666667, 0, 1.00000157, 50000, 3650000
* "Margaret River Coastal Grid 1984", 8, 13, 7, 115.1, 0, 1.000014, 50000, 4050000
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+ "Margaret River Coastal Grid 1994", 8, 116, 7, 115.166666666667, 0, 1.0000055, 50000, 4050000
+ "Perth Coastal Grid 1984", 8, 13, 7, 115.833333333334, 0, 1.000006, 40000, 3800000

+ "Perth Coastal Grid 1994", 8, 116, 7, 115.816666666667, 0, 0.99999906, 50000, 3800000

+ "Port Hedland Grid 1984", 8, 13, 7, 118.583333333334, 0, 1.000004, 50000, 2400000

+ "Port Hedland Grid 1994", 8, 116, 7, 118.6, 0, 1.00000135, 50000, 2400000

Balkans Coordinate Systems

We have added new Balkans coordinate systems:

» "MGI / Balkans Zone 7\p31277", 8, 9999, 10,577.326,90.129,463.919,5.137,1.474,5.297,2.4232,
0,7, 21,0, 0.9999, 7500000, 0

* "Hungarian Projection System (EOV) - Updated", 8, 1023, 7, 19.04857178, 47.14439372, 0.99993,
650000, 200000

Krovak Coordinate Systems
We have added new Krovak coordinate systems:

+ "S-JTSK (Krovak) Coordinate system - Updated\p102067", 32, 1024, 7, 24.833333333333, 49.5,
78.5, 30.28813972222222, 0,0

« "JTSKO3 for Slovak Republic", 32, 1025, 7, 24.833333333333, 49.5, 78.5, 30.28813972222222,
0,0

» "S-JTSK (Krovak) Coordinate system", 32, 1020, 7, 42.5, 49.5, 78.5, 30.28813972, 0, 0

Swiss Coordinate Systems (bounded)
We have added new Swiss coordinate systems:

+ "CH1903.LV03 bounded",2025, 158, 7, 7.439583333333, 46.952405555556, 600000, 200000,
-1000000, -1000000, 3000000, 3000000

+ "CH1903plus.LV95 bounded",2025, 158, 7, 7.439583333333, 46.952405555556, 2600000,
1200000, 1000000, 0, 5000000, 4000000

New in Proviewer 12.0

Support for Additional Coordinate Systems

Extended Transverse Mercator Coordinate Systems

We have added a new Transverse Mercator (WGS 84) coordinate system based on "A highly
accurate world wide algorithm for the transverse Mercator mapping (almost)" by K. E. Engsager
and K. Poder, 2007:

» "Extended TM Zone 1, Northern Hemisphere (WGS 84)", 34, 104, 7, -177, 0, 0.9996, 500000, 0

» "Extended TM Zone 1, Southern Hemisphere (WGS 84)", 34, 104, 7, -177, 0, 0.9996, 500000,
10000000
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"Extended TM Zone 2, Northern Hemisphere (WGS 84)", 34, 104, 7, -171, 0, 0.9996, 500000, 0
"Extended TM Zone 2, Southern Hemisphere (WGS 84)", 34, 104, 7, -171, 0, 0.9996, 500000,
10000000

"Extended TM Zone 3, Northern Hemisphere (WGS 84)", 34, 104, 7, -165, 0, 0.9996, 500000, 0

"Extended TM Zone 3, Southern Hemisphere (WGS 84)", 34, 104, 7, -165, 0, 0.9996, 500000,
10000000

"Extended TM Zone 4, Northern Hemisphere (WGS 84)", 34, 104, 7, -159, 0, 0.9996, 500000, 0

"Extended TM Zone 4, Southern Hemisphere (WGS 84)", 34, 104, 7, -159, 0, 0.9996, 500000,
10000000

"Extended TM Zone 5, Northern Hemisphere (WGS 84)", 34, 104, 7, -153, 0, 0.9996, 500000, 0

"Extended TM Zone 5, Southern Hemisphere (WGS 84)", 34, 104, 7, -153, 0, 0.9996, 500000,
10000000

"Extended TM Zone 6, Northern Hemisphere (WGS 84)", 34, 104, 7, -147, 0, 0.9996, 500000, 0

"Extended TM Zone 6, Southern Hemisphere (WGS 84)", 34, 104, 7, -147, 0, 0.9996, 500000,
10000000

"Extended TM Zone 7, Northern Hemisphere (WGS 84)", 34, 104, 7, -141, 0, 0.9996, 500000, 0

"Extended TM Zone 7, Southern Hemisphere (WGS 84)", 34, 104, 7, -141, 0, 0.9996, 500000,
10000000

"Extended TM Zone 8, Northern Hemisphere (WGS 84)", 34, 104, 7, -135, 0, 0.9996, 500000, 0

"Extended TM Zone 8, Southern Hemisphere (WGS 84)", 34, 104, 7, -135, 0, 0.9996, 500000,
10000000

"Extended TM Zone 9, Northern Hemisphere (WGS 84)", 34, 104, 7, -129, 0, 0.9996, 500000, 0

"Extended TM Zone 9, Southern Hemisphere (WGS 84)", 34, 104, 7, -129, 0, 0.9996, 500000,
10000000

"Extended TM Zone 10, Northern Hemisphere (WGS 84)", 34, 104, 7, -123, 0, 0.9996, 500000, 0

"Extended TM Zone 10, Southern Hemisphere (WGS 84)", 34, 104, 7, -123, 0, 0.9996, 500000,
10000000

"Extended TM Zone 11, Northern Hemisphere (WGS 84)", 34, 104, 7, -117, 0, 0.9996, 500000, 0

"Extended TM Zone 11, Southern Hemisphere (WGS 84)", 34, 104, 7, -117, 0, 0.9996, 500000,
10000000

"Extended TM Zone 12, Northern Hemisphere (WGS 84)", 34, 104, 7, -111, 0, 0.9996, 500000, 0

"Extended TM Zone 12, Southern Hemisphere (WGS 84)", 34, 104, 7, -111, 0, 0.9996, 500000,
10000000

"Extended TM Zone 13, Northern Hemisphere (WGS 84)", 34, 104, 7, -105, 0, 0.9996, 500000, 0

"Extended TM Zone 13, Southern Hemisphere (WGS 84)", 34, 104, 7, -105, 0, 0.9996, 500000,
10000000

"Extended TM Zone 14, Northern Hemisphere (WGS 84)", 34, 104, 7, -99, 0, 0.9996, 500000, 0

"Extended TM Zone 14, Southern Hemisphere (WGS 84)", 34, 104, 7, -99, 0, 0.9996, 500000,
10000000

"Extended TM Zone 15, Northern Hemisphere (WGS 84)", 34, 104, 7, -93, 0, 0.9996, 500000, 0

"Extended TM Zone 15, Southern Hemisphere (WGS 84)", 34, 104, 7, -93, 0, 0.9996, 500000,
10000000
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+ "Extended TM Zone 16, Northern Hemisphere (WGS 84)", 34, 104, 7, -87, 0, 0.9996, 500000, 0

» "Extended TM Zone 16, Southern Hemisphere (WGS 84)", 34, 104, 7, -87, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 17, Northern Hemisphere (WGS 84)", 34, 104, 7, -81, 0, 0.9996, 500000, 0

» "Extended TM Zone 17, Southern Hemisphere (WGS 84)", 34, 104, 7, -81, 0, 0.9996, 500000,
10000000

 "Extended TM Zone 18, Northern Hemisphere (WGS 84)", 34, 104, 7, -75, 0, 0.9996, 500000, 0

» "Extended TM Zone 18, Southern Hemisphere (WGS 84)", 34, 104, 7, -75, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 19, Northern Hemisphere (WGS 84)", 34, 104, 7, -69, 0, 0.9996, 500000, 0

» "Extended TM Zone 19, Southern Hemisphere (WGS 84)", 34, 104, 7, -69, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 20, Northern Hemisphere (WGS 84)", 34, 104, 7, -63, 0, 0.9996, 500000, 0

+ "Extended TM Zone 20, Southern Hemisphere (WGS 84)", 34, 104, 7, -63, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 21, Northern Hemisphere (WGS 84)", 34, 104, 7, -57, 0, 0.9996, 500000, 0

» "Extended TM Zone 21, Southern Hemisphere (WGS 84)", 34, 104, 7, -57, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 22, Northern Hemisphere (WGS 84)", 34, 104, 7, -51, 0, 0.9996, 500000, 0

» "Extended TM Zone 22, Southern Hemisphere (WGS 84)", 34, 104, 7, -51, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 23, Northern Hemisphere (WGS 84)", 34, 104, 7, -45, 0, 0.9996, 500000, 0

+ "Extended TM Zone 23, Southern Hemisphere (WGS 84)", 34, 104, 7, -45, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 24, Northern Hemisphere (WGS 84)", 34, 104, 7, -39, 0, 0.9996, 500000, 0

» "Extended TM Zone 24, Southern Hemisphere (WGS 84)", 34, 104, 7, -39, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 25, Northern Hemisphere (WGS 84)", 34, 104, 7, -33, 0, 0.9996, 500000, 0

+ "Extended TM Zone 25, Southern Hemisphere (WGS 84)", 34, 104, 7, -33, 0, 0.9996, 500000,
10000000

 "Extended TM Zone 26, Northern Hemisphere (WGS 84)", 34, 104, 7, -27, 0, 0.9996, 500000, 0

+ "Extended TM Zone 26, Southern Hemisphere (WGS 84)", 34, 104, 7, -27, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 27, Northern Hemisphere (WGS 84)", 34, 104, 7, -21, 0, 0.9996, 500000, 0

» "Extended TM Zone 27, Southern Hemisphere (WGS 84)", 34, 104, 7, -21, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 28, Northern Hemisphere (WGS 84)", 34, 104, 7, -15, 0, 0.9996, 500000, 0

» "Extended TM Zone 28, Southern Hemisphere (WGS 84)", 34, 104, 7, -15, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 29, Northern Hemisphere (WGS 84)", 34, 104, 7, -9, 0, 0.9996, 500000, 0

» "Extended TM Zone 29, Southern Hemisphere (WGS 84)", 34, 104, 7, -9, 0, 0.9996, 500000,
10000000
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+ "Extended TM Zone 30, Northern Hemisphere (WGS 84)", 34, 104, 7, -3, 0, 0.9996, 500000, O

» "Extended TM Zone 30, Southern Hemisphere (WGS 84)", 34, 104, 7, -3, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 31, Northern Hemisphere (WGS 84)", 34, 104, 7, 3, 0, 0.9996, 500000, 0

+ "Extended TM Zone 31, Southern Hemisphere (WGS 84)", 34, 104, 7, 3, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 32, Northern Hemisphere (WGS 84)", 34, 104, 7, 9, 0, 0.9996, 500000, 0

» "Extended TM Zone 32, Southern Hemisphere (WGS 84)", 34, 104, 7, 9, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 33, Northern Hemisphere (WGS 84)", 34, 104, 7, 15, 0, 0.9996, 500000, 0

 "Extended TM Zone 33, Southern Hemisphere (WGS 84)", 34, 104, 7, 15, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 34, Northern Hemisphere (WGS 84)", 34, 104, 7, 21, 0, 0.9996, 500000, O

+ "Extended TM Zone 34, Southern Hemisphere (WGS 84)", 34, 104, 7, 21, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 35, Northern Hemisphere (WGS 84)", 34, 104, 7, 27, 0, 0.9996, 500000, O

» "Extended TM Zone 35, Southern Hemisphere (WGS 84)", 34, 104, 7, 27, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 36, Northern Hemisphere (WGS 84)", 34, 104, 7, 33, 0, 0.9996, 500000, 0

» "Extended TM Zone 36, Southern Hemisphere (WGS 84)", 34, 104, 7, 33, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 37, Northern Hemisphere (WGS 84)", 34, 104, 7, 39, 0, 0.9996, 500000, 0

+ "Extended TM Zone 37, Southern Hemisphere (WGS 84)", 34, 104, 7, 39, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 38, Northern Hemisphere (WGS 84)", 34, 104, 7, 45, 0, 0.9996, 500000, 0

» "Extended TM Zone 38, Southern Hemisphere (WGS 84)", 34, 104, 7, 45, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 39, Northern Hemisphere (WGS 84)", 34, 104, 7, 51, 0, 0.9996, 500000, O

+ "Extended TM Zone 39, Southern Hemisphere (WGS 84)", 34, 104, 7, 51, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 40, Northern Hemisphere (WGS 84)", 34, 104, 7, 57, 0, 0.9996, 500000, 0

+ "Extended TM Zone 40, Southern Hemisphere (WGS 84)", 34, 104, 7, 57, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 41, Northern Hemisphere (WGS 84)", 34, 104, 7, 63, 0, 0.9996, 500000, 0

» "Extended TM Zone 41, Southern Hemisphere (WGS 84)", 34, 104, 7, 63, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 42, Northern Hemisphere (WGS 84)", 34, 104, 7, 69, 0, 0.9996, 500000, O

» "Extended TM Zone 42, Southern Hemisphere (WGS 84)", 34, 104, 7, 69, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 43, Northern Hemisphere (WGS 84)", 34, 104, 7, 75, 0, 0.9996, 500000, 0

» "Extended TM Zone 43, Southern Hemisphere (WGS 84)", 34, 104, 7, 75, 0, 0.9996, 500000,
10000000
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» "Extended TM Zone 44, Northern Hemisphere (WGS 84)", 34, 104, 7, 81, 0, 0.9996, 500000, 0
» "Extended TM Zone 44, Southern Hemisphere (WGS 84)", 34, 104, 7, 81, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 45, Northern Hemisphere (WGS 84)", 34, 104, 7, 87, 0, 0.9996, 500000, O

» "Extended TM Zone 45, Southern Hemisphere (WGS 84)", 34, 104, 7, 87, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 46, Northern Hemisphere (WGS 84)", 34, 104, 7, 93, 0, 0.9996, 500000, 0

» "Extended TM Zone 46, Southern Hemisphere (WGS 84)", 34, 104, 7, 93, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 47, Northern Hemisphere (WGS 84)", 34, 104, 7, 99, 0, 0.9996, 500000, 0

» "Extended TM Zone 47, Southern Hemisphere (WGS 84)", 34, 104, 7, 99, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 48, Northern Hemisphere (WGS 84)", 34, 104, 7, 105, 0, 0.9996, 500000, 0

+ "Extended TM Zone 48, Southern Hemisphere (WGS 84)", 34, 104, 7, 105, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 49, Northern Hemisphere (WGS 84)", 34, 104, 7, 111, 0, 0.9996, 500000, 0

» "Extended TM Zone 49, Southern Hemisphere (WGS 84)", 34, 104, 7, 111, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 50, Northern Hemisphere (WGS 84)", 34, 104, 7, 117, 0, 0.9996, 500000, 0

» "Extended TM Zone 50, Southern Hemisphere (WGS 84)", 34, 104, 7, 117, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 51, Northern Hemisphere (WGS 84)", 34, 104, 7, 123, 0, 0.9996, 500000, 0

+ "Extended TM Zone 51, Southern Hemisphere (WGS 84)", 34, 104, 7, 123, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 52, Northern Hemisphere (WGS 84)", 34, 104, 7, 129, 0, 0.9996, 500000, 0

» "Extended TM Zone 52, Southern Hemisphere (WGS 84)", 34, 104, 7, 129, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 53, Northern Hemisphere (WGS 84)", 34, 104, 7, 135, 0, 0.9996, 500000, 0

+ "Extended TM Zone 53, Southern Hemisphere (WGS 84)", 34, 104, 7, 135, 0, 0.9996, 500000,
10000000

 "Extended TM Zone 54, Northern Hemisphere (WGS 84)", 34, 104, 7, 141, 0, 0.9996, 500000, 0

+ "Extended TM Zone 54, Southern Hemisphere (WGS 84)", 34, 104, 7, 141, 0, 0.9996, 500000,
10000000

+ "Extended TM Zone 55, Northern Hemisphere (WGS 84)", 34, 104, 7, 147, 0, 0.9996, 500000, 0

» "Extended TM Zone 55, Southern Hemisphere (WGS 84)", 34, 104, 7, 147, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 56, Northern Hemisphere (WGS 84)", 34, 104, 7, 153, 0, 0.9996, 500000, 0

+ "Extended TM Zone 56, Southern Hemisphere (WGS 84)", 34, 104, 7, 153, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 57, Northern Hemisphere (WGS 84)", 34, 104, 7, 159, 0, 0.9996, 500000, 0

» "Extended TM Zone 57, Southern Hemisphere (WGS 84)", 34, 104, 7, 159, 0, 0.9996, 500000,
10000000
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» "Extended TM Zone 58, Northern Hemisphere (WGS 84)", 34, 104, 7, 165, 0, 0.9996, 500000, 0
» "Extended TM Zone 58, Southern Hemisphere (WGS 84)", 34, 104, 7, 165, 0, 0.9996, 500000,
10000000

» "Extended TM Zone 59, Northern Hemisphere (WGS 84)", 34, 104, 7, 171, 0, 0.9996, 500000, 0

+ "Extended TM Zone 59, Southern Hemisphere (WGS 84)", 34, 104, 7, 171, 0, 0.9996, 500000,
10000000

 "Extended TM Zone 60, Northern Hemisphere (WGS 84)", 34, 104, 7, 177, 0, 0.9996, 500000, 0

» "Extended TM Zone 60, Southern Hemisphere (WGS 84)", 34, 104, 7, 177, 0, 0.9996, 500000,
10000000

South America Coordinate Systems

This release adds support for SIRGAS 2000 datum commonly used in South America. We support
highly accurate NTv2 datum transformation between Corrego Alegre and SIRGAS 2000 datum.
Also, the NTv2 transformation is supported for datum transformation between South American 1969
and SIRGAS 2000 datum.

We added the following SIRGAS 2000 based coordinate systems:

* "Longitude / Latitude (SIRGAS 2000)\p4674", 1, 160

* "UTM Zone 11, Northern Hemisphere (SIRGAS 2000)\p31965", 8, 160, 7,-117, 0, 0.9996, 500000,
0

* "UTM Zone 12, Northern Hemisphere (SIRGAS 2000)\p31966", 8, 160, 7,-111, 0, 0.9996, 500000,
0

» "UTM Zone 13, Northern Hemisphere (SIRGAS 2000)\p31967", 8, 160, 7, -105, 0, 0.9996, 500000,
0

* "UTM Zone 14, Northern Hemisphere (SIRGAS 2000)\p31968", 8, 160, 7, -99, 0, 0.9996, 500000,
0

* "UTM Zone 15, Northern Hemisphere (SIRGAS 2000)\p31969", 8, 160, 7, -93, 0, 0.9996, 500000,
0

« "UTM Zone 16, Northern Hemisphere (SIRGAS 2000)\p31970", 8, 160, 7, -87, 0, 0.9996, 500000,
0

» "UTM Zone 17, Northern Hemisphere (SIRGAS 2000)\p31971", 8, 160, 7, -81, 0, 0.9996, 500000,
0

» "UTM Zone 17, Southern Hemisphere (SIRGAS 2000)\p31977", 8, 160, 7, -81, 0, 0.9996, 500000,
10000000

* "UTM Zone 18, Northern Hemisphere (SIRGAS 2000)\p31972", 8, 160, 7, -75, 0, 0.9996, 500000,
0

* "UTM Zone 18, Southern Hemisphere (SIRGAS 2000)\p31978", 8, 160, 7, -75, 0, 0.9996, 500000,
10000000

* "UTM Zone 19, Northern Hemisphere (SIRGAS 2000)\p31973", 8, 160, 7, -69, 0, 0.9996, 500000,
0

« "UTM Zone 19, Southern Hemisphere (SIRGAS 2000)\p31979", 8, 160, 7, -69, 0, 0.9996, 500000,
10000000
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+ "UTM Zone 20, Northern Hemisphere (SIRGAS 2000)\p31974", 8, 160, 7, -63, 0, 0.9996, 500000,
0

* "UTM Zone 20, Southern Hemisphere (SIRGAS 2000)\p31980", 8, 160, 7, -63, 0, 0.9996, 500000,
10000000

* "UTM Zone 21, Northern Hemisphere (SIRGAS 2000)\p31975", 8, 160, 7, -57, 0, 0.9996, 500000,
0

* "UTM Zone 21, Southern Hemisphere (SIRGAS 2000)\p31981", 8, 160, 7, -57, 0, 0.9996, 500000,
10000000

* "UTM Zone 22, Northern Hemisphere (SIRGAS 2000)\p31976", 8, 160, 7, -51, 0, 0.9996, 500000,
0

» "UTM Zone 22, Southern Hemisphere (SIRGAS 2000)\p31982", 8, 160, 7, -51, 0, 0.9996, 500000,
10000000

* "UTM Zone 23, Southern Hemisphere (SIRGAS 2000)\p31983", 8, 160, 7, -45, 0, 0.9996, 500000,
10000000

+ "UTM Zone 24, Southern Hemisphere (SIRGAS 2000)\p31984", 8, 160, 7, -39, 0, 0.9996, 500000,
10000000

* "UTM Zone 25, Southern Hemisphere (SIRGAS 2000)\p31985", 8, 160, 7, -33, 0, 0.9996, 500000,
10000000

Swedish Coordinate Systems

We added EPSG codes for the following coordinate systems:

+ "SWEREF 99 TM\p5845", 8, 33, 7, 15, 0, 0.9996, 500000, 0
+ "SWEREF 99 12 00\p5846", 8, 33, 7, 12.00, 0, 1, 150000, 0
+ "SWEREF 99 13 30\p5847", 8, 33, 7, 13.50, 0, 1, 150000, 0
+ "SWEREF 99 15 00\p5848", 8, 33, 7, 15.00, 0, 1, 150000, 0
+ "SWEREF 99 16 30\p5849", 8, 33, 7, 16.50, 0, 1, 150000, 0
+ "SWEREF 99 18 00\p5850", 8, 33, 7, 18.00, 0, 1, 150000, 0
+ "SWEREF 99 14 15\p5851", 8, 33, 7, 14.25, 0, 1, 150000, O
+ "SWEREF 99 15 45\p5852", 8, 33, 7, 15.75, 0, 1, 150000, O
« "SWEREF 99 17 15\p5853", 8, 33, 7, 17.25, 0, 1, 150000, O
+ "SWEREF 99 18 45\p5854", 8, 33, 7, 18.75, 0, 1, 150000, 0
+ "SWEREF 99 20 15\p5855", 8, 33, 7, 20.25, 0, 1, 150000, 0
+ "SWEREF 99 21 45\p5856", 8, 33, 7, 21.75, 0, 1, 150000, 0
+ "SWEREF 99 23 15\p5857", 8, 33, 7, 23.25, 0, 1, 150000, 0

New in Proviewer 11.5

Select All Records in a Browser Window

You can now select all rows/records from a table. Click the grey triangle icon beside the first column
heading to select all records and perform an operation on the entire table, map or map layers.
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New Look for the Browser Window

Introduction to MapInfo ProViewer

The Browser window has a new look and improved usability for viewing and data. It now:

 Displays a very light background color on alternating rows for better readability.
+ Highlights an entire selected row. Previous versions use a small box at the left of the row to indicate

selection state.

The highlight color is set by your Windows display settings (by a theme). Highlighting does not
appear in Layout windows or in printouts.

= WORLD Browser [f=lrm] = |
Country Capital Continent
Aruba Oranjestad  Morth America é

Antigua and Barbuda 5t Johns  Morth America
United Arab Emirates Abu Dhabi | Asia
Afghanistan Kabul Asia

EEER— e
Azerbaijan Baku Europe

Albania Tirane Europe ~
4 m 3

Figure 1: A selected row in a Browser window.

Multi-line text may display in any column, not just in expressions. Before version 11.0 Maplnfo
ProViewer ignored carriage return characters in your data. As of version 11.0, Mapinfo ProViewer
displays a row over multiple lines.

Changing Column Width

To resize a single column width, either:

+ Click and drag the edge of the column header.

Maplinfo ProViewer 15.0

User Guide
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+ Position the mouse cursor between two column headings and then double-click. The column to
the left of the cursor resizes to fit the data in view.

Scrolling and Viewing Data
To reposition the column within the current view, select and drag a column heading.

If you use the scroll bars to scroll, the current cell does not change position. This is similar to Microsoft
Access and other programs, so the current cell can be out of view.

Displaying a Map in Mapinfo ProViewer

To explore the basics of desktop mapping concepts, let’s explore the WORL.D . WOR workspace, which
is installed with ProViewer under the Data/Wor1d subfolder (for example, C: \Program
Files\MapInfo\ProViewer\Data\World\WORLD.WOR).

To display a map in the ProViewer product:

1. Click the Start button and then select All Programs > Mapinfo > MapInfo ProViewer to display
the ProViewer window.

2. Click the Open Tables or Workspaces * tool or select File > Open to display the Open MaplInfo
Tables or Workspaces dialog box.

[ Open Maplnfo Tables or Workspaces ==
p——
(L)) 1 « Data » Introductory Data » Werld » ~ [ 42 ][ search werta P
Organize * New folder =~ 0 @
- Favorites * Name Date modified Type  *
T
B Desktop Africa 7/26/201311:19 AM  File folde
& Downloads Asia 7/26/201311:19 AM  File folde
il Recent Places Australia 7/26/201311:19 AM  File folde

Europe /201311:19 AM  File folde|E

- Libraries PostalBoundaries 311:20 AM  Filefolde
5 Documents  |= Workspes 7/26/201311:19 AM  File folde
& Music World_WMS 7/26/201311:19 AM  File folde
= Pictures B GazmaTAB 5/23/20138:07 AM  Maplnfo
=]l Subversion [ GazmIN.TAB 5/23/2013 84 Maplnfo
B videos B> GRrIDI5.TAB 5/23/2013 8 Maplnfo

B Mors_100kTAB 5/23/2013 8 Maglnfo
1% Computer BB Mgrs_Nor 100k.TAB 5/23/2013 8 Maplnfo
&L Local Disk (C:) P Mgrs_Sou_100k TAB 5/23/2013 8 Maglnfo
BB naoee 1in€ oo TaD 33015 07 AMA haecraiit T
~ 7T . r
File name: | + |Maplnfo Tables and WorkSpace
Cancel

Note: You cannot open .MWS files created with Maplnfo Pro in ProViewer.

3. Click the Data directory and click Open.
4. Click the World directory and click Open.
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5. Select the World.wor entry and click Open to display the World workspace.

Understanding the ProViewer Toolbar

The toolbar icons at the top of the MaplInfo ProViewer window can help you perform mapping work

easily and efficiently. The Help System contains a detailed explanation of each icon

3
Open Tables or Workspace w Invert Selection Iﬂﬂl Graph Select
* Select %:' Print Window '{ Zoom Out
? T
“ Change View “ Zoom In 1'} Info Tool

4
I—@ Drag Map Window

m
“._/ Grabber

=
=—I Show/Hide Legend

il
< Label

& Ruler

-
44 Show/Hide Statistics

& Boundary Select

&5 HotLink

k Radius Select

LI Polygon Select

& Marquee Select

@ Unselect All

Maplinfo ProViewer 15.0 User Guide
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A Brief Tour of the World.wor Workspace

Use the WORLD . WOR workspace, installed with ProViewer, to review the map layers and experiment
with these icons to become familiar with their functionality. You can think of a workspace as a map
with transparencies stacked on top of it. Each layer contains data that pertains to the entire map.
For example, WORLD . WOR includes the Ocean, the Countries, and the World Capitals layers.

The WORLD . WOR workspace is located under the Data/Wor1d subfolder where ProViewer is installed
(for example, C: \Program Files\MapInfo\ProViewer\Data\World\WORLD.WOR).

Using the Select Tool

Click the Select * tool and then position the cursor over any region to display the name of the
region. There are several selection icons that allow you to select map features and group regions
for display. See the Help System for more about the specific properties of each tool.

Using the Statistics Tool

Click the Show/Hide Statistics Z tool to display more about a selected country in the Statistics
window.

Maplinfo ProViewer 15.0 User Guide
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Statistics (=]

TANZANIS, UNITED REPUBLIC OF Table: World o
Records Selected: 1

Field Sum Average
ZAMBIA

MUmEric_code 454 454
Pop_1994 5,556,200 5,556,200
Pop_Grwe_Rt 18 1.8
Pap_Mals 4,173,900 4,173,900

Pop_Fem 4,382,300 4,382,300

MOZAMBIQUE | | pop 0 14 4,132 900 4,132,900
Pop_15_B4 4,207 400 4,207 400
Pop_BSPlus 215,900 215,800
Male_0_14 2,062,500 2,062,600

Male_15_64 2,015,400 2015400 |~
q

Using the Ruler Tool
The Ruler tool can show distance between two points on a Map window.

Choose the Ruler < tool and position the cursor, which displays as a cross, anywhere on the
map and click.

‘—'_\AII Malai

Zamhbia Ailon g
Mozambicue

E] N

Zimbakroe Ruler

Distance =320 mi (Spherical)
“wlarare Total =320 mi (Spherical)

The Ruler window displays Distance and Total. As you move the cursor, the Distance measurement
changes in the Ruler window.

» To measure the distance between two points, click the first point and double-click the second.

» To measure the length of a path containing two or more segments, continue the process, clicking
once at the end of each segment to keep a running total of the length of the path.

Using the Zoom Tools

The zoom options give you control over the display of the Map window.
1. Open a Map window and click the Zoom-in “ tool. Position the cursor anywhere on the map.
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Mfaleroi

Zamhia

Mozambicue

Fimbakwe

>

Full featured Pitney Bowes Software products allow you to determine the range (for example 0
to 3 miles, 2 to 5 miles) at which each layer is visible in a Map window.

2. To see the effect of zooming click the Zoom-in tool anywhere on the map. The map redraws at
the new zoom level. Notice that the information changes in the Zoom section of the Status Bar
to reflect a new zoom level.

Zoom: 11,900 mi Editing: Mane Selecting: Mone

3. To specify the zoom level of the map, click the Change View “ tool and enter a new zoom level.

Change View @

Zoom [windaw Widh]. mi

Map Scale Tin= a0 mi

Cartographic Scale: 1: 45560000

Center of Windauw: Ho298 deg Y 404 deg

ak ]I Cancel J{ Help

At different zoom levels, new information displays on the map reflecting the visibility of the different
map layers that comprise WORLD . WOR.

Displaying the Map Legend
The map’s legend explains the meaning of the different shapes, colors, and fill patterns.

1. Open a Map window and click the Show/Hide Legend - tool or select the Options menu and
the Show/Hide Legend command.
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B2 wiarld

[ Legend De.. [ = [ = |[aEsa]

‘ (&) 1000 ~ R
1994 Growth Rates f
Fopulation Growth Rate

@ 63
ﬂ\ 315

i 083
Industrial Growth Rate

-11.6 to 22 (19)
I 44 to 115 )

15t0 44 (33
21to 15 (132)
88 to 21 (23

MADAGASCAR

OUTH AFRICA

Note: Not all maps have legends.

2. Choose the Map menu option and the Previous View command to return the map from the
beginning.

Getting Online Help

Use ProViewer's comprehensive online Help, including sections on menu commands and dialog
box descriptions, to answer your ProViewer questions.

Getting Technical Support

If you encounter problems installing MaplInfo ProViewer, our technical support specialists can help.

Technical Support for Maplnfo ProViewer is limited to installation issues. For workspace-related
issues, see the Maplnfo Pro user who created the workspace.

To contact the office nearest you, refer to the Contact Support section on our website:
http://www.mapinfo.com/support

Maplinfo ProViewer 15.0 User Guide
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Want to do more?

Consider...

Maplnfo Pro, the premier desktop mapping product for business and government. Maplinfo Pro
allows users to access their own data to see relationships between data and geography, answering
questions such as...

» Where are my best customers located?
* Where should | place my next sales office?
* How can | increase my sales?

Maplnfo Pro answers these questions in a straightforward manner, reducing the time it takes to
make smarter decisions.
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A - Glossary

If you do not find the term you are looking for in this glossary, check the
glossary in the Mapinfo Pro User Guide on the Maplnfo Pro DVD or in the
Maplinfo Pro Help System.

In this section

Definition of Terms 26




Glossary

Definition of Terms

aggregate functions

In MapBasic, functions such as Sum( ) and Count( ) that calculate summary information about
groups of rows in a table. See Select in the MapBasic Reference Guide or Help System.

Browser window

In Maplnfo Pro, a window for viewing a table (or database, spreadsheet or text file) in tabular form.

coordinate

An x,y location in a Cartesian coordinate system, or a Latitude, Longitude location in an earth
coordinate system. Coordinates represent locations on a map relative to other locations. Earth
coordinate systems may use the equator and the Greenwich prime meridian as fixed reference
points. Plane coordinate systems describe a two-dimensional X,y location in terms of distance from
a fixed reference and are usually in the first quadrant so that all coordinates are positive numbers.

degrees longitude, degrees latitude, decimal degrees

Degrees (longitude and latitude) are coordinates used to represent locations on the surface of the
earth. Longitude, or X-coordinate, represents a location’s east-west position, where any location
west of the prime meridian has a negative X value. Latitude, or Y-coordinate, represents a location’s
north-south position, where any location south of the equator has a negative Y value.

field

In Mapinfo Pro, a field in a table corresponds to a column in a Browser. A field contains a specific
type of information about an object, such as, name, abbreviation, land area, price, population, and
so forth. The record for each object consists of that object’s values for each of the fields in the
database.

graticule

A grid of horizontal (latitude) and vertical (longitude) lines displayed on an earth map, spaced at a
regular distance (for example, every five degrees, every fifteen degrees). Used to establish a frame
of reference.
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latitude

The horizontal lines on a map that increase from 0 degrees at the Equator to 90 degrees at both
the North (+90.0 degrees) and South (-90.0 degrees) poles. Used to describe the North-South
position of a point as measured usually in degrees or decimal degrees above or below the equator.

legend

The part of a map, which explains the meaning of different colors, shapes, or fill patterns used on
the map.

longitude

The vertical lines on a map, running from the North to South poles, used to describe the east-west
position of a point. The position is reported as the number of degrees east (to -180.0 degrees) or
west (to +180.0 degrees) of the prime meridian (0 degrees). Lines of longitude are farthest apart at
the Equator and intersect at both poles, and therefore, are not parallel.

map scale

A statement of a measure of the map and the equivalent measure on the earth. Often expressed
as a representative ratio of distance, such as 1:10,000. This means that one unit of distance on the
map (for example, one inch) represents 10,000 of the same units of distance on the earth.

The term scale must be used carefully. Technically, a map of a single city block is large—scale (for
example, 1:12,000), while a map of an entire country is small-scale (for example, 1:1,000,000). A
1:1,000,000 map is considered small-scale because of the small numeric value obtained when you
divide 1 by 1,000,000.

Map window

A window that allows you to view a table as a map.

node

An end-point of a line object, or an end-point of a line segment which is part of a polyline or region
object.

raster image

A type of computerized picture consisting of row after row of tiny dots (pixels). Raster images are
sometimes known as bitmaps. Aerial photographs and satellite imagery are common types of raster
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data found in GIS. A computer image can be represented in raster format or in vector format. See
Vector Image on page 28.

record

All the information about one object in a database or table. A record in a table corresponds to a row.

selection

In Maplnfo Pro, a data item or set of data items chosen for inspection and/or analysis. Regardless
of the kinds of windows on the screen, selections can be made using the Select and SQL Select
Query commands in MaplInfo Pro’s Query menu. In Browsers and Map windows, items can be
placed in the selection set by clicking on them individually. Map windows also have special tools
for selecting multiple items on a spatial basis.

status bar

In Maplnfo Pro, a bar at the bottom of the screen that displays messages that help in using Maplnfo
Pro. The StatusBar also displays messages that pertain to the active window. In a Map window, the
StatusBar indicates what layer is editable, the zoom display of the map, and the status of Snap and
Digitizing modes. In a Browser window, the StatusBar indicates the number of records currently
displaying and the total number of records. In a Layout window, the StatusBar indicates the zoom
display as a percentage of the actual size of the map.

table

A table is made up of data in rows and columns. Each row contains information about a particular
geographic feature, event, etc. Each column contains a particular kind of information about the items
in the table. You can display tables with graphic information stored in them as maps.

Vector Image

A coordinate-based data structure commonly used to represent map features. Each object is
represented as a list of sequential x,y coordinates. Attributes may be associated with the objects.
A computer image can be represented in vector format or in raster format. See raster image on
page 27.

workspace

A saved configuration of open Maplnfo tables and windows.
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zoom layering

A setting that determines the range (for example, 0—3 miles, 2—-5 miles, etc.) at which a layer is
visible in a Map window.
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